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PERFACE
The student industrial work experience scheme (SIWES) comprises of knowledge I gained during the training programme. The programme is enhanced from Higher Industrial of training to expose the student to the practical aspect of their field.
However, this programme makes student to have good orientation on their course of study improve them practical through the experience gained.
More so, more companies and industries should be asset to create room for those that are unable to get a place to attach themselves for the training because it will promote the technological activities in the country.


TABLE OF CONTENT
Title Page									i		
Dedication									ii
Acknowledgement								iii
Preface									iv 
Table of Content								v
CHAPTER ONE
1.1	Introduction							1
1.2	Objectives Of Siwes						1
1.3	Importance Of Siwes						2
1.4	The Role Of Federal Government 				2
1.5	Role Of The Co-Ordnating Agency (NUC)			2
1.6	Role Of The Industrial Training Fund (ITF)			2
1.7 	Role Of Employers						3
1.8	Role Of Polytechnics 						3
1.9	Role Of Students							3
CHAPTER TWO
2.0	Historical Background Of Ministry Of Agriculture And Rural Development 
										4
2.1	Vision And Mission Statements				4
2.2	Policy Thrusts							4
2.3	Aims/Objectives Of The Ministry				4
CHAPTER THREE
2.0	WORK EXPERIENCE GAINED
2.1 Nature of Activities Carried Out During the Training Programme
2.2 Tools and Equipment Used
2.3 Relation of the Training to the Course of Study
MS Word
the uses of MS Word?
How to create an MS Word document?
Features of MS Word
CHAPTER FOUR	
4.0	Problem Encountered During The Attachment And Solution 
4.1	Possible Solution							21 
4.2	Conclusion 								21
vi

CHAPTER ONE
INTRODUCTION
1.0 	BRIEF HISTORY OF SIWES
The Student Industrial Work Experience Scheme (SIWES), also known as Industrial Training is a compulsory Skills Training Programme designed to expose and prepare students of Nigerian Universities, Polytechnics, Colleges of Education, Colleges of Technology and Colleges of Agriculture, for the industrial work situation they’re likely to meet after graduation.
The scheme also affords students the opportunity of familiarizing and exposing themselves to the needed experience in handling equipment and machinery that are usually not available in their institution. The scheme also affords students the opportunity of familiarizing and exposing themselves to the needed experience in handling equipment and machinery that are usually not available in their institution. The duration of SIWES is four months in Polytechnics at the end of NDI, four months in College of Education at the end of NCE II and six months in the Universities at the end of 300, 400 or 500 level depending on the course of study and departments preference.

The government’s decree No. 47 of 8th Oct; 1971 as amended in 1990, highlighted the capacity building of human resources in industry, commerce and government through training and retraining of workers in order to effectively provide the much needed high quality goods and services in a dynamic economy as ours (Olusegun A.T. Mafe, 2009). This decree led to the establishment of Industrial Training Fund (ITF) in 1973/1974.
The growing concern among our industrialists that graduates of our institutions of Higher learning, lack adequate practical background studies preparatory for employment in industries, led to the formation of students Industrial Work Experience Scheme (SIWES) by ITF in 1993/1994(Olusegun A.T. Mafe, 2009).

[bookmark: _GoBack]Before the establishment of the scheme, there was a growing concern among industrialists, that graduates of institutions of higher learning lacked adequate practical background studies preparatory for employment in industries. Thus, employers were of the opinion that the theoretical education in higher institutions wasn’t responsive to the needs of the employers of labour. SIWES introduction, initiation and design was done by the Industrial Training Fund (I.T.F) in 1993 to acquaint students with the skills of handling employer’s equipment and machinery. The Industrial Training Fund (I.T.F) solely funded the scheme during its formative years. However, due to financial constraints, the fund withdrew from the Scheme in 1978.
The Federal Government, having noticed the significance of the skills training handed the management of the scheme to both the National Universities Commission (N.U.C) and the National Board for Technical Education (N.B.T.E in 1979. The management and implementation of the scheme was however reverted to the I.T.F by the Federal Government in November, 1984 and the. administration was effectively taken over by the Industrial Training Fund in July 1985, with the funding solely borne by the Federal Government. ITF has as one of its key functions; to work as cooperative entity with industry and commerce where students in institutions of higher learning can undertake mid-career work experience attachment in industries which are compatible with student’s area of study.
1.1	AIMS AND OBJECTIVES OF SIWES
The objectives of SIWES among others includes:
i. SIWES provide an avenue for students in higher institutions to acquire industrial skills and experience in their approved course of study.
ii. It Prepare students for possible industrial works situation which they may meet when they graduate.
iii. It makes the transition from school to the world of work easier and enhance students contact for future job opportunities.
iv. Provide students with an opportunity to apply their knowledge in real work situation thereby bridging the gap between theory(classroom) and practice(industry).
v. Enlist and strengthen employers’ involvement in the entire educational process and prepare students for absorption into the field after graduation.
vi. Expose students to work methods and techniques in handling equipment and machinery which may not be available in their institutions.


1.2	BENEFITS OF SIWES TO STUDENTS
It affords the student an opportunity to learn how to function in multi-disciplinary teams.
i. Students can now effectively communicate within the working environment.
ii. It provides the opportunity for students to understand professional and ethical responsibilities more.
iii. The scheme provides an opportunity for the industries to evaluate prospective employees and give healthy feedback to the institutions.
iv. It gives opportunity for the student to make better mastery of the theoretical knowledge acquired in classrooms using practical knowledge acquired in the industry.
v. It enhances the student’ attitudes to work like commitment, dedication, punctuality, politeness, effective communication and such like.
1.3          BODIES INVOLVED IN THE MANAGEMENT OF SIWES
The bodies involved are: Federal Government, Industrial Training Fund (ITF), Other Supervising Agencies are: National University Commission (NUC), National Board for Technical Education (NBTE) & National Council for Colleges of Education (NCCE), Institutions of learning (say, UBITS Department in the case of University of Benin)
i. The functions of these agencies above include among others to:
ii. Ensure that the scheme is adequately funded
iii. Establish SIWES and accredit SIWES unit in the approved institutions.
iv. Formulate policies and guideline for participating bodies and institutions as well as appointing SIWES coordinators and supporting staff.
v. Supervise students at their places of attachment and sign their log-book and ITF Forms.
vi. Vet and process student’s log-books and forward same to ITF Area office
Ensure payment of Allowances for the students and supervisors.




Chapter two 
[image: ]1.3 Organizational Structure of the firm/organization
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CHAPTER THREE 
2.0	WORK EXPERIENCE GAINED
The first day of my arrival into the company. It was an induction exercise. I was shared different sectors of department.
The first week of resumption It was basically am induction week. We were exposed to different section of the department and various personnel. We were also shown the working environment comprises of various offices, toilets etc. And also the basic rules and regulations of the company.
The second week, I carried out some office duties like typing of document using the Microsoft word and excel/ we carried out cleaning routines of arrangement of files and errands for the manager.
The third week, we were taught some office ethic like attendance to work on time, good communication skills and appearance.
2.1 Nature of Activities Carried Out During the Training Programme
The nature of activities was fundamentally on practical work. Series of guides and instructions was given to me on the first week of commencement and subsequent week emphasis was on some theoretical knowledge on quickBooks accounting software.
The practical activities were learning how to draw and prepare sales, debtors and debt recouped analysis, and as well as accounting and auditing of financial reports. Furthermore, I also learnt how to make good use of quickbooks accounting software.
2.2 Tools and Equipment Used
In performing certain accounting functions or in carrying out accounting operations, some set of equipments and tools are required to make the job easier. Some tools and equipments that were exposed to me include: computer, printer, banknotes counter or bill counter machine, quickbooks.  
1. Computer
A computer is an electronic device for storing and processing data, typically in binary forms according to instructions given to it in a variable program.
[image: ]A computer helps an accountants to store and access financial records, make changes and alleviate the need to keep paper files. Some popular uses of the computers in offices include preparation of word documents such as letters, reports, processing if work documents such as work orders and financial reports, presentation of reports and proposals to and behalf of executive and higher level of office personnel.
2. Printers
A printer is a hardware output device that is used to generate hard copy and print any document.
[image: ]A document can be of any type such as a text file, image or the combination of both. The accountant uses the printer to print out important documents such as accounting documents, employee information, customers information etc.
3. Bank note counter or bill counter
[image: ]A currency counting machine is a machine that counts money either in stacks of banknotes or loose collections of coins. Currency counters are commonly used in vending machines to determine what amount of money has been deposited by customers, it also detects counterfeit bill (the machine stops when it reaches a counterfeit bill).

4. Quickbooks
[image: ]Quickbooks is an accounting software just as sage and others. It is a great business accounting software for small to mid-sized business owners. It helps save time on bookkeeping and paper work. It automatically handles some of the easy bookkeeping tasks, saving your time and making your day easier. It also provides tools to making your day easier. It also provides tools to manage your customers, vendors, clients inventory and finances.
2.3 Relation of the Training to the Course of Study
The correlation of the training to the Course of Study is that of the practical job and functions that was executed during the attachment period. Most of the theoretical work done in the school such as source documents, journal entries, double entry concept of bookkeeping etc, were all practically done during the training period.
Microsoft Word 
Microsoft Word is a word processing program that allows users to create, edit, and format documents. It's part of the Microsoft Office suite and is one of the most widely used programs. 
What is MS Word?
Used to make professional-quality documents, letters, reports, etc., MS Word is a word processor developed by Microsoft. It has advanced features which allow you to format and edit your files and documents in the best possible way. 
Where to find MS Word on your personal computer?
Follow these simple steps to open MS Word on your personal computer:
Start → All Programs → MS Office → MS Word.
What are the uses of MS Word?
MS Word enables users to do write-ups, create documents, resumes, contracts, etc. This is one of the most commonly used programs under the Office suite. 
How to create an MS Word document?
To create an MS Word doc, follow the steps mentioned above to open Microsoft Word. Then once the program is open, click on “File” followed by “New”. This opens a new doc where something new can be created.
Since it is used by people of all age groups, in schools, in colleges and for official purposes, having proper knowledge of Microsoft Word is a must. The preview of the MS Doc file once it is opened is given below:
[image: MS Word Document]
Also, from a competitive exam perspective, one must be well aware of this topic. To get the list of all major Government exams conducted in the country, aspirants can visit the linked article. 
For a better understanding of how MS Word works and the features that are included in it, you can refer to the video given below and analyse its functioning easily.
[image: https://cdn1.byjus.com/wp-content/uploads/2020/09/MS-Word-video.jpg]
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Features of MS Word
Now let us read more about the features and components of an MS Word doc file in detail.
The image given below shows the different elements and categories which are available in MS Word doc:
[image: MS Word - Features of Microsoft Word]
· Home
This has options like font colour, font size, font style, alignment, bullets, line spacing, etc. All the basic elements which one may need to edit their document is available under the Home option.
· Insert
Tables, shapes, images, charts, graphs, header, footer, page number, etc. can all be entered in the document. They are included in the “Insert” category.
· Design
The template or the design in which you want your document to be created can be selected under the Design tab. Choosing an appropriate tab will enhance the appearance of your document.
· Page Layout
Under the Page Layout tab comes options like margins, orientation, columns, lines, indentation, spacing, etc. 
· References
This tab is the most useful for those who are creating a thesis or writing books or lengthy documents. Options like citation, footnote, table of contents, caption, bibliography, etc. can be found under this tab.
· Review
Spell check, grammar, Thesaurus, word count, language, translation, comments, etc. can all be tracked under the review tab. This acts as an advantage for those who get their documents reviewed on MS Word.
Apart from all the above-mentioned features, the page can be set in different views and layouts, which can be added and optimised using the View tab on the Word document. Margins and scales are also available for the benefit of the users. 
When compared with MS PowerPoint, MS Word is more of reading while PPT is more of visual and graphical representation of data. 
To know more about Microsoft Windows, visit the linked article.
For Govt exam aspirants, given below are links to the other subjects which are a part of the competitive exam syllabus:
	Logical Reasoning
	Quantitative Aptitude

	Verbal Ability
	Current Affairs

	Static GK
	Banking Awareness


Uses of MS Word
Given below are the different fields in which MS Word is used and simplifies the work of an individual:
· In Education: It is considered as one of the simplest tools which can be used by both teachers and students. Creating notes is easier using MS Word as they can be made more interactive by adding shapes and images. It is also convenient to make assignments on MS Word and submitting them online
· In Workplace: Submitting letters, bills, creating reports, letterheads, sample documents, can all easily be done using MS Word
· Creating & Updating Resume: One of the best tools to create your resumes and is easy to edit and make changes in it as per your experience
· For Authors: Since separate options are available for bibliography, table of contents, etc., it is the best tool which can be used by authors for writing books and adjusting it as per the layout and alignment of your choice
Also, creating a Doc file and converting it into PDF is a more suitable option, so it is highly recommended. 



CHAPTER FOUR
CONCLUSION AND RECOMMENDATIONS
4.1    CONCLUSION
Generally, I have been able to discuss SIWES itself. Its history, purpose, bodies involved in its management and its benefit to the students. Also, we now know what Business Administration is about and how to become a qualified Business Administrator in Nigeria. Above all, the wonderful experiences I gained during the period of my training have all been concisely outlined too including Managing, Organizing, Supervision, Preparation of BoQ, Office management, Programme of work, Contract Administration.
Until now, I have always esteemed managing as the peak of Business Administration practice, I had little awareness of the professional ethics required in Business Administration and I also did not see must importance on basic attitudes to work especially punctuality. All these and several other fallacies I had in mind about quantity have been carted away by the educative, practical and first-class professional training I received during my Internship at Loy hotel. Now, I am able to synergize what I have been learning in classroom with what is applicable in the industry.
Although much have been learnt during the period of my training, but majority of my experiences are related to management because I was attached to a Management firm. Also, the passive nature of the hospitality market in Ogun unlike Abuja and Lagos affects flow of jobs which causes dormancy at times.
I hope it only gets better with SIWES in department of Busness Admnstration. The limitations in the preceding paragraph can be taken into consideration and possible solutions made for better performance of the SIWES program.
4.2	RECOMENDATIONS
As it has been noted earlier, the one-sided nature of my experience as regards business Administration in a consultant is a challenge in the sense that few knowledge about administration was gained. Also, the poor market competition in Ogun State causes dormancy at times in companies because no or less work is at hand to do. In addition to these, inadequate supervision from the institution is a problem as this may cause some students to take the program less seriously.
It is therefore recommended that students be supervised on regular basis during the training say, monthly. This is to ensure that the students are assessed on the job and to keep track on how the students are improving on the job. I also recommend that the institution create structure whereby students can easily move from one organization to the other without difficulty in situation where the initial organization has less than three departments.
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